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Introduction

Introduction

Mesh mode is a Delta Licence option for projection onto non-planar objects or surfaces.

A 3D model or ‘mesh’ of the projection surface is required, to provide calibration points

for the media. This model could come from laser-scanning an object or surface, or from

original design (e.g. a digitally-designed manufactured object). There are two modes, depending on the

preparation of the projected media: projection and textured.

This guide will take you through the process of matching your mesh model and media to the real life

environment.
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Projection and Textured Modes Explained

Projection and Textured Modes Explained

Projection Mode

The 3D Object/Surface

Multiple projectors can be used to display an image on a 3D surface that is

designed to be viewed from a single design eyepoint. Essentially this

creates a static situation where the object and projectors cannot change in

relation to each other without losing alignment, and content will be

absent from any other viewpoint, such as the reverse side of the object.

Imagine rotating a cube in front of you: you will never be able to see more

than three faces at once. This does not mean you cannot have design

renders for other sides of an object, but that these are regarded as

separate projections. Designer, projectors and the viewer are all observing

the object from the same place, though the projectors can be offset.

The 3D Model

A 3D model is a system of co-ordinates (‘nodes’ or

‘vertices’) joined in a mesh. The co-ordinates take as

their reference a zero-point (or origin) within (or

outside) the model of the reference object. The

model can be rotated and viewed from any angle, but

when used for projection mapping, the designer will

take a chosen viewpoint (or eyepoint) that ‘projects’

an orientation from which the object will be viewed.

The 2D Media

Because the designer’s reference point is the origin

of the model, the media effectively represents what

the origin of the model would see in a mirror. For

better and sharper results, the media can be

displayed over several projectors, and it may be

better to split a complex mesh model into more

manageable pieces for those projectors, but

projection mode still assumes that the designer and

viewer are both looking at the media-painted object

from the same view of the model. 
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Projection and Textured Modes Explained

Textured Mode

The 3D Object/Surface

Just as the 3D model can be rotated and viewed from

any angle, so the viewer can either move around the

model, or the object can be rotated, and the media

will ‘stick to’ and move precisely with the object.

Here is a demonstration model of a totem head with

easy-to-identify surfaces.

The 3D Model

The 3D model is constructed in the same way, but its

entire external surface is notionally ‘peeled off’ or

unfolded onto a flat surface. This surface is ‘painted’

by the designer to create specially rendered 2D

media. Whilst the object and model are described in

X × Y × Z axes, the surface is described in the 2D U × V

axes, hence UV-rendered or mapped media.

In this illustration a simple cube demonstrates the

theory of what can be actually a more complex

mapping, as in the ‘totem head’ example used here.
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Projection and Textured Modes Explained

The 2D UV-Mapped Media

For the designer, all viewpoints now are

perpendicular to the model/object surface, rather

than, say an oblique view of the side of a cube. In

textured mode, the characteristics of the mesh

model surface are ‘baked’ into the flat media, which

is then folded back onto the model in the projection.

Compare this UV-mapped media frame with the one

used above for projection mode. The top row of faces

are projected on the other side of the object, either

by rotating the object into projector view, or by

providing all-round channel coverage.

The reason this media does not look simply unfolded

as in the cube above, is that this would create a lot of

empty space in every frame. Instead, the elements

are packed into the 2D space, with mapped

coordinates that are used to place them on the target

object or canvas.

This is how the UV media looks in the Playback

Window when ‘folded’ or positioned back onto the

model, as seen from a single channel. The yellow

lines show the model origin (X,Y,Z = 0,0,0); red, green

and blue are the X, Y, Z axes.
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Mesh Mode Setup

Mesh Mode Setup

How Mesh Mode works

In mesh mode generally, there are a number of key elements:

· Representing a real-world object as a 3D mesh of points (saved in a .obj file).

· For projection mode situations, designing flat media with a defined eyepoint.

· For texture mode situations,‘ unwrapping’ the 3D mesh model onto a 2D UV surface, and mapping

the media onto it.

· Calibrating the virtual positioning of projectors in Delta, to their precise real-world positions.

· Using DeltaGUI to relate the software mesh model in the server, back to the real world object and

projector positions.

· Using DeltaGUI to apply warping and blending for seamless joins and perfect fit.

Flat Projection Mode

Here is an example of a theatre for display in mesh mode, with a 3D canvas and two offset projectors:
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Mesh Mode Setup

This test model features flat and curved surfaces, detail in the 7thSense logo, and a face with a highly

detailed mesh, in front. Whilst the projectors are pitched down, the design eyepoint (red and green axis

planes) is horizontal. Here is how each virtual projector in DeltaGUI will see the canvas (in this case a 3D

object), and note that they may see surfaces the viewer is not designed to see, or even for which there

is no media coverage:

· In Delta, we must set up the render camera eyepoint of non-UV media, as defined in the media. This

we do know exactly.
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Mesh Mode Setup

· We also need to know the projector locations for pitch, heading and field of view – but we can’t

know these exactly.

· By giving Delta enough reference points from the .obj file, placed in real space, Delta can work out

how to warp the flat media from any angle, into exact position.

Already we can see that projecting non-UV-mapped media onto very oblique faces may reduce

sharpness, and in this model it may even be better to have a separate mesh for the face on the front,

with a separate head-on projector to avoid shadows. Delta can handle up to 16 meshes per show, and 32

channels.

Textured (UV-mapped) Mode

The theatre setup may be the same as above, but the UV-mapped media will be wrapped to the surface

exactly the same way as the .obj model grid shown. Alignment is much easier, though the media

construction is more complex.
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Mesh Setup Basic Sequence

Mesh Setup Basic Sequence

Assumptions

· You have a theatre set up with projectors and display canvas / objects.

· You have .obj mesh files that cover every part of your display.

· You have media that is either for flat projection, or is UV-mapped to the mesh, for textured mode.

Sequence in DeltaGUI

1. Check your canvas size and render settings :  Display > Mesh Mode > Mesh Canvas 

2. Set your active channels : Display > Mesh Mode > Channel, and

3. use the Defaults Wizard to distribute your virtual projectors.

4. Add your mesh files : Display > Mesh Mode > Mesh > Mesh Files 

5. Set your parameters for each required eyepoint (not required for UV-mapped media in textured

mode) : Display > Mesh Mode > Mesh > Eyepoint Files > Eyepoint Details + Parameters (see Setting

an Eyepoint in Delta ), and

6. assign eyepoints to the meshes where they are to be used.

7. Set your eyepoint mode to ‘Use Texture Coordinates’ (not required for flat media in projected

mode) : Display > Mesh Mode > Mesh > Eyepoint Files > Eyepoint Details 

8. Use 3D Projector Calibration  with any timeline media disabled and full grid display on, for each

channel to select and align each required mesh, with the projectors and real-life canvas. For this

stage, keep all channels active, but turn beams off except for the channel being aligned.

9. Apply (or enable) timeline media and view for where correction and adjustment is needed.

10. Edit the mesh , apply channel distortion, or media warps to correct for real-life canvas, and

minor .obj or media errors.

12

20

35
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Setting an Eyepoint in Delta

Setting an Eyepoint in Delta

Eyepoints are always associated with meshes. UV-mapped media for textured mode effectively has an

infinite number of eyepoints, but for projected mode, there will always be one precise eyepoint in the

media. If you are not using UV-mapped media in textured mode, then you must obtain the eyepoint

data from the content creator, or from within the media (e.g. Cinema 4D).

In Channel or Interactive view, click Eyepoint to view the Eyepoint

parameters. Using the small L button, make sure the field of view (FOV)

parameters are displayed as Left / Right / Top / Bottom (rather than lens

aspect and zoom). Each set of parameters is just a translation of the other, but

for translating render camera data from Cinema 4D, we need this view.

Enter the eyepoint data, as translated from C4D render camera details:

DeltaGUI eyepoint Cinema 4D FOV

Left (negative) of horizonta l  FOV × 0.5

Right (positive) of horizonta l  FOV × 0.5

Top (positive) of vertica l  FOV × 0.5

Bottom (negative) of vertica l  FOV × 0.5

Heading (negative) of C4D va lue

Pitch (positive) of C4D va lue

Rol l (positive) of C4D va lue (most l ikely 0)

X (positive) of C4D

Y (positive) of C4D

Z (negative) ofC4D foca l  length



13

DeltaGUI Mesh Mode                                                                                                                                                 © 2018 7thSense Des ign

DeltaGUI Mesh Mode Controls

DeltaGUI Mesh Mode Controls

With DeltaServer running and the Playback Window in full screen, select Mesh mode in DeltaGUI.

Choose your required 2D or 3D media mode from the Mesh Mode drop-down:

There are three control panels here:

Channel Panel: Setting up your Projectors

Here you set the projector positions as in any mode. The process of calibration will automatically make

fine adjustment to these.

As for any mode, select the active channels you will be using, with the small ‘C’ button.

Note the two places where channel beams can be switched on and off: in the foot of the channels

panel (click the colours), and bottom right in the DeltaGUI status bar. You will need to switch beams

off for calibrating individual channels. Do not deactivate channels for this operation.
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DeltaGUI Mesh Mode Controls

The defaults wizard dialog behaves the same as Dome Mode, but be aware you are typically arranging

channels around an object at a centre, so use Projectors Outside Screen. Note that ‘Include Cap’ is not

relevant to this mode.

Channel Size

Select from the two options. Use Existing Size (if the display model is the same as previous show)

or Force Size and type in the settings according to the design guidelines.

Channels Used

Select the number of channels (projectors) in ‘Force n Channels’, or ‘Use Existing Channels’ if

active channels already set up.

Screen

Set screen radius here if using ‘Projectors at Screen Edge’ in channel arrangement, or Use Existing

Screen if using ‘Projectors outside Screen’.

Spacing

If set to Calculate, projectors will be assumed to be all-round, in equal divisions of 360°. Changes

to each projection can then be adjusted accordingly at a later stage.

Channel Arrangement

For Projectors at Screen Edge set a screen radius above; for Projectors outside Screen set a radius

here.
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DeltaGUI Mesh Mode Controls

At Radius

This is the visualised distance from the object origin.

Mesh Canvas Panel

Canvas Size

Your dimensions here for projected (not textured) mode will be defined by the media.

Render Size

This is for tuning performance by reducing resolution to decrease the load on the graphics card.

(Preserve the aspect ratio.)

Active Render

This is the location of the render on the overall canvas.

Mesh Panel

Here, you have five different views:

· Channel: shows the view of the mesh surface covered by (as ‘seen’ by) a single channel i the GUI. It

is here (or Interactive view) that you set a fixed eyepoint.

· Interactive: allows the whole model, axes and projector frustums (yellow lines) to be rotated and

viewed in the playback window:

· 3D Projector Calibration : place the mesh vertices on the actual canvas points20
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DeltaGUI Mesh Mode Controls

· Mesh Editor : alter the mesh by overlaying adjustments

· Movement Nodes : synchronise media movements between eyepoints and between meshes.

For projection mode (not textured) you must know the design eyepoint for the media, for each

channel.

Mesh Dimensions

3D models are ‘ideal’, and even if used as the basis for constructing the actual real-world object (our

canvas) there will be differences. DeltaGUI provides for all reasonable adjustments, but the mesh

model must be accurate and to scale. Beyond this, the mesh itself may require editing.

· First of all, the eyepoint of the designer/viewer must be related to the origin (X, Y, Z = 0, 0, 0) of the

mesh model.

Typically left as 0, 0, 0, you can reposition the object away from its inherent origin if necessary.

· If there is a difference in the scale of the model and the actual object, this must be adjusted.

Set to 1.0 by default. You can adjust the size of the model if the object dimensions are not fully to

scale, but of course the projector locations may then have to be altered to account for the new

object size.

· If there is any difference in heading, pitch or roll of the actual object from that expected by the

projected media, these too can be adjusted.

Heading, Pitch and Roll values are in degrees. The 3D object may come in rotated about the wrong

axis, so you can correct this here.

Mesh (.obj file) Selection

For DeltaGUI and DeltaServer to work together, each mesh .obj file must be on both the DeltaGUI PC

and the server, in C:\meshes. When you assign a mesh in DeltaGUI, a copy of the server mesh will be

synced to the DeltaGUI PC. Their filenames must stay the same in both locations.

In Channel view, select both mesh and eyepoint for each channel:

35

40
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DeltaGUI Mesh Mode Controls

Double-click an ID line to add or to remove a mesh from a channel. You can apply multiple meshes per

channel, up to 16 per show.

Visible

A mesh can be assigned but only be visible in the GUI, not playback, by selecting No.

Project on Mesh

If you do not want media to appear, but you still want to be able to see and illuminate the object

with the grid off, a mesh can be rendered in greyscale.
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DeltaGUI Mesh Mode Controls

Eyepoint Selection

In this example (not a textured mode example), it is assumed that this eyepoint will apply to all meshes

in all channels. Each mesh can have a different viewpoint or more than one viewpoint. Different meshes

can share the same viewpoint. Eyepoints are available to all, or selected channels only.

Using texture coordinates with UV-mapped media means that the model, grid, media and object can all

be aligned in one calibration operation.

Eyepoints can also be assigned to media by right-clicking the resource on the timeline:
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DeltaGUI Mesh Mode Controls

Enabled:

Enable or disable this eyepoint. Disabling will hide related meshes.

Use Texture Coordinates:

Enable this if the .obj file contains texture coordinates, if you enable this and the model has no

texture coordinates, nothing will show on this mesh. Disable this, and the flat plane canvas will be

projected from an eyepoint configured in the GUI. 

Use Depth:

Enable (default) to have occlusion between meshes, disable and the meshes will not occlude

against each other (determined by the order shown in the mesh files dialog).

Orthographic:

Choose this to have an orthographic (non-lens based) eyepoint, note this only applies to a

Projected (non-textured) eyepoint.

Enabled Meshes:

Choose the meshes related to this eyepoint.

Enabled Output channels:

Choose which output display channels will render this eyepoint.
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3D Projector Calibration

3D Projector Calibration

Now that the physical projectors are set up correctly for the media and model eyepoint, the model can

be calibrated to the real-life object or canvas. This is done by projecting the mesh using the grid, with its

edges and vertices, rather than the media, onto the object. Each channel is calibrated separately. The

media is the same, the mesh is the same, and Delta does all the maths required to adjust for each

projector position.

Per Channel Setup

With the Playback Window in full-screen mode, and DeltaGUI in Display > Mesh, with the mesh files set

up as above, turn the grid on to 100%. (Grid size: the spacing of the .obj mesh depends on the file itself.)

The grid will not show until a channel is calibrated.

If any warps or blends are on the timeline, you will see a red warning, and a checkbox to disable them.

This is because the undistorted mesh must be added to the real-world canvas. Warps and blends can be

applied to the media once calibration is complete.

Turn the beams off all but the channel you are calibrating.

In the Mesh panel, select 3D Projector Calibration view:

Click the triangle button to select ‘Use 3D Calibration’,

and ensure your reference mesh for this channel is

correctly showing.

Lens mode can be manual (e.g. just adjust for wide

angle), or default (recommended). You may find

progressively unchecking K6, K5, K4 ... in turn, makes

some minor improvements, but only after you have a

grid display to look at.

2D/3D view toggle

This is the button you will use to move between

selecting a vertex from the model and placing it

precisely on the object. 2D view shows the model, 3D

shows the object.
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3D Projector Calibration

Calibration Points

Calibration requires at least 6 distinctive and distributed reference points (mesh vertices) to be

accurately positioned, using DeltaGUI, on the object. Delta will infer the relative position of all other

vertices, which is why a good 3-dimensional spread of calibration points is needed. Delta will then

automatically calculate the mapping of the whole .obj mesh onto the object. This initial calibration may

be sufficient, but further reference points can be selected and adjusted thereafter.

In 2D view, position the mesh model (this may be out of view, but the RESET button will recentre it).

Manipulation of the model using the mouse buttons is the same as shown in Interactive view (shown

right). This takes practice, but will be useful in being able to quickly rotate the model for a clear view of

the vertices you want to use (rather than a node right behind it).

Mouse controls:

· Left-click + drag : pan and tilt the whole mesh

· Right-click + drag : shift the whole mesh

· Centre-click + drag : zoom

· Shift+left + drag : spin the mesh around a set point in 3D space

Hint: in Mesh Editor  view , you can change the size of the dots marking vertices with Node Size .

The movement of the mouse can also be adjusted, to control the responsiveness of the mesh image.

35 35
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3D Projector Calibration

When a node point is found, the dot is grey. When a vertex is selected, it is red. When it has been set, it

shows green. 
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3D Projector Calibration

Select a vertex, and switch to 3D view. Now look at the object/canvas and just move the mouse (no

buttons) to drag the white cross-hairs in a red box, over the same point in the object:

Press Ctrl + left-click to register this point, and the lines will turn green. This point will now be listed in

DeltaGUI with its 3D XYZ model coordinates and 2D channel-frustum location. The mouse position need

only be approximate: after registering the point, you can nudge it into more exact position with Ctrl +

arrows or Ctrl+Shift+arrows (fine control). You can choose later not to use it, if for some reason it is not

being useful, or you can readjust it by selecting from the list in 3D mode (it will be shown on the object)

and nudging it again.
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3D Projector Calibration

When you have 6 registered points, DeltaGUI will calculate the whole mesh, and the whole grid will be

displayed on the object. It should be a reasonably good fit. There are two obvious points here that can

be selected to improve the result:
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3D Projector Calibration

Now look around the other side, which will be covered by the second projector, and we see that it might

be better not to include part of the mesh here at all:

We can calibrate the second projector now, and return to the mesh editor  later to tidy up, and to

hide or fade these faces per channel. 

35
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3D Projector Calibration

Here is one completed channel in DeltaGUI:

Editing Calibration Points

To adjust any point, select it in the list (make sure you don’t deselect it in the checkbox) in 3D mode,

and it will show a red box around the vertex on the object. Nudge it into a better position with 

Ctrl+arrows or Ctrl+Shift+arrows (fine control).

Clear: If you want to start over, click ‘Clear’.

: Delete a selected point only.
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3D Projector Calibration

Add Manually: If you have precise calibration points available from tracking software such as BlackTrax,

these can be added manually:

Viewing the Result

Now take the grid display off, and go back to DeltaGUI > Layers and add or enable your media in the

Timeline, and your media should fit the object. UV-mapped media is baked into the .obj model, but flat-

projected media may take additional adjustment for a perfect fit.
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Warping in Mesh Mode

Warping in Mesh Mode

It may be useful to warp the mesh as a whole, rather than manipulating the mesh .obj or the canvas,

especially if it just involves regular or geometric deformation. Timeline media warps must be disabled

during calibration, but can be added and adjusted afterwards. The warp must be applied to the

background layer, and not the media channel but the respective mesh.

Delta will allow one or two meshes to have background warps applied:

· to apply a warp to the first mesh (ID=1), assign it to channel 17

· to apply a warp to the second mesh (ID=2), assign it to channel 18

Note: these are not ‘active’ channels.
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Blending in Mesh Mode

Blending in Mesh Mode

In mesh mode, flat blends offer an additional choice. The Resource Editor for flat blends placed on the

timeline (background layer) have this additional tab of settings:

Projected mode only: the blend can be restricted to not only channel (in the Timeline tab) but particular

eyepoints, and with the choice of where it applies. ‘Channel’ will apply it as normal to the periphery of

the projector frustum, ‘Source Texture’ will apply it to the periphery of the media frame.

Textured Mode: the blend target should be ‘Channel’.

This is similar to being able to warp the canvas, or apply warps to media.
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Troubleshooting Projection Mode

Troubleshooting Projection Mode

Fitting the Mesh

If, having positioned six calibration points, the whole projected grid is very wrong, this could be either

due to poor distribution of points or a mistaken vertex between the mesh and real life (perhaps behind

the one you think it is). 

· Try switching off individual calibration points in case one in particular is bad.

· Try adding one further point, perhaps where the projected grid is most out of position.

· Check the Lens Modes in the 3D Projector Calibration panel. Are you using the recommended

defaults? Try unchecking and checking Fixed Aspect, Zero Tangential, and K6, K5, K4 for best

improvement.

· Discrepancies between the mesh and the real life surface can also be corrected for by editing points

on the mesh .

Fitting the Media

Delta works out how the projectors fit the model to reality. If the media designer has worked from the

same model and scale, and rendered it correctly, and you have compensated for irregularities in the

real-life canvas, then the single crucial error may be setting the eyepoint position in Delta, so check this

carefully first.

· If the eyepoint is correct, some warping of the canvas may be appropriate. Add a flat geometry to

the background layer, assign the channel in the Resource Editor, and use channel point distortion

warp (see this section under Display Configuration, in the Delta User Guide).

· If the overall correction required seems geometric, try warping the mesh as a whole (see Warping in

Mesh Mode ).

· If the mesh and media correspond and the required adjustment is small, then the media can also be

surface warped into a better fit. Place a flat geometry on the timeline in the same layer as your

media. Go to Warp and ease the media into place. Remember that Surface Warp has two different

interpolation methods. Spline method moves points in smooth arcs, warping a greater area than the

linear method, which moves the point(s) in straight lines, within its own area, without affecting the

rest of the image. The H+, H-, V+ and V- buttons increase the grid density (click then ‘Apply’ or

Enter), which affects the area of warping.

35

28
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Troubleshooting Projection Mode

For more guidance on surface warp, see this section under Display Configuration, in the Delta User

Guide.



32

DeltaGUI Mesh Mode                                                                                                                                                 © 2018 7thSense Des ign

Working in Textured Mode

Working in Textured Mode

Working in textured mode is little different, but since there is no single eyepoint, parameters need not

be added. When assigning an eyepoint for each channel in Display > Mesh Mode > Mesh > Eyepoint Files

> Eyepoint Details, make sure you are using texture coordinates:
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Multiple Meshes and Media

Multiple Meshes and Media

Delta can manage up to 16 meshes. Since in mesh mode, media can be associated with specific

eyepoints, and eyepoints can be associated with specific meshes, we can have simultaneous media on a

timeline, to be projected onto separate objects using their own meshes. Here we have two images, and

have assigned them to different eyepoints by disabling all others:

Here we have two meshes, for a tube and a cube, set up in DeltaGUI, with different eyepoints assigned

to them:
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Multiple Meshes and Media

Here in Playback we have media 1, associated with eyepoint 1,which is associated with mesh 1 (the

cube), and media 2, associated with eyepoint 2, which is associated with mesh 2 (the tube):

Note that the media eyepoints are using textured coordinates.
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Editing a Mesh

The Mesh Editor allows you to manipulate the mesh as a whole, per channel, by vertex or group of

vertices, with control over the editing view. The X, Y, Z axes throughout are those based on the .obj

model’s origin.

Even if you are not editing points, the mesh editor has settings for moving the mesh around in the GUI,

with slider controls for Node Size and Mouse movement size.

Movement Plane

Select which 2D plane (axis pair) in which you want to move selected vertices, in the overall 3D

space.

Movement Size

The Vertex slider controls sensitivity of selected vertex movement, using Ctrl+arrows. The Mouse

slider controls the speed at which the mouse drags the mesh around in the GUI.

Drawing Mode

These options enable you to see the entire mesh, or focus on the foreground only. The result will

depend in part on the way the mesh has been constructed.
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Movement: World or Per Channel

Choose whether you want to manipulate the mesh for a particular channel only, or for all channels

(World view). Per channel is generally best for small adjustments, and World if there is a

significant error in the media across the whole object. These edits are overlaid on the .obj mesh

and will be saved as separate .vto files. The Disable buttons switch the adjustment overlays off

and on without resetting the model.

Selection Mode

Vertices can be selected either to reposition them, or to change their visibility (as in the oblique

faces of our object example above). Select a single vertex to move it, or a group of vertices. The

group selection area finds all vertices within an XY window as seen from the current viewpoint in

the GUI. The size of this window can be controlled by the size slider. Click the lock button for

separate X and Y axis sizes. Selection includes all vertices in this rectangle, in all planes. Add more

vertices to the group selection with Ctrl+left click. Near or far vertices can be excluded by working

in a clipping plane (see below). For multiple selection of individual vertices, use a very small

group area.

In this example: red points are a selected group with equal XY selection. Green shows the mouse

hovering over another group with a limited X axis and mid-range Y (see settings on the right).

Moving points: Once selected, all red nodes can be moved around en bloc using Ctrl+arrows. For

finer movement, use Ctrl+Shift+arrows. Movement is along the X, Y, Z axes of the .obj file, based

on the object origin. Selected vertices or the whole model can be reset using the Reset buttons

(bottom right).

Hiding points: There are two ways to affect the projected display of selected parts of the media:

Show/Hide and Black/Paint. Hiding a group removes all edges joined to the selected vertices, and

enclosed faces. Single vertex selection is not useful for hiding, but a single vertex in a small group

may be. In the example below, per channel selection has been made on the oblique sides in
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Editing a Mesh

channel 1 (left), to be filled exclusively by channel 2 (right). In the first Playback Window

illustration below, Hide removes faces from display, in the second, Black fades it out, similar to

blending.

Note how vertex selection has not included the vertical edges required by channel 1.

Compare this with adding a blend , and the need to preserve display on edges; a blend may

fade out more than you want. Blends are more suitable for textured mode.

29
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Editing a Mesh

When mesh editing, Playback will show in blue-green colour, indicating that it is in low-

performance mode. Restore this by going back to channel mode.

Clipping Planes

These contain your view for selection, between Near and Far planes. Use the Fit button to set the

range to the size of your mesh, otherwise the mesh can be too small a part of the maximum

available range, and disappear from view. In this example, clipping planes have been used to limit

selection to points on the facing wall in the above illustration:
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Save Meshes

You can save changes to the mesh simply by using File > Save As (and then Save to save further

changes). This saves the original .obj file, together with .vto files containing adjustment

instructions. Every time the mesh is used for a show, these instructions will be applied. ‘World’

and ‘Per Channel’ change files are created separately.

To remove the changes, returning to the original mesh alone, simply reset in the GUI or delete the

.vto files here. If you have ‘Sync Mesh Files from Server’ ticked in the Mesh selection screen, the

files will also be copied over automatically to the GUI.

The mesh editor, however, also allows you to ‘bake’ the changes into either a new single revised

‘world’ .obj file, or a new .obj per channel. Changes cannot be reset in a ‘baked’ file.

Reset Meshes

Note that resetting the whole model sets all vertices back to their original positions in their obj

file. If you have loaded an .obj file that has associated .vto files, resetting the model removes the

.vto amendments from view, and if then saved, the .vto files are removed from the C:\Meshes

directory. If in doubt, and you want to compare before and after adjustments, use the Disable

button instead.
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Movement Nodes

Movement nodes add the capability to synchronise movement between meshes, media and eyepoints

using their names in Sequences (see Delta User Guide). By manipulating a parent node, linked nodes

will follow without separate programming. Examples include rotating images on car wheels, growing

and moving two eyes together, or bringing several meshes into view simultaneously.

The three controls create or delete nodes (third button), assign nodes to

eyepoints (first button), and to meshes (middle button).

Creating a Movement Node

There are six sequences of Translate (change XYZ coordinates), Rotate (HPR angles) and Scale (XYZ

relative dimensions), though not all three aspects may be needed:

· To synchronise multiple movement nodes, one must be a parent and the others assigned to it.

· Movement nodes are assigned to eyepoints and/or meshes.
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· Movement nodes can also be addressed by External Controls (see the Delta User Guide for how to

use these). For available commands in DeltaGUI, Click Help > External Controls and find Movement

Node Commands:
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